
Calcium signaling in Hela cells. IP3/RyR receptors and SERCA pump.  
K. Essin. 
 
Introduction: 

Cells have two major types of intracellular Ca2+ release channels – inositol 1,4,5-
triphosphate (IP3) and ryanodine receptors (RyRs)1. IP3 receptors are activated by IP3, 
following G protein-coupled receptor (GPCRs) receptor stimulation. Human cervical 
cancer cell line (HeLa cells) expresses endogenous GPCRs - histamine H1 2 and 
muscarinic cholinergic receptors (Schonbrunn A. and Steffen D., “Endogenous GPCR list 
in common cell lines”, http://www.tumor-gene.org/GPCR/gpcr.html). Therefore, 
application of histamine and carbachol (CCh), a non-hydrolysable cholinergic agonist, 
provokes a remarkable release of Ca2+ from intracellular stores in HeLa cells (Fig. 5). 
RyRs are activated by external Ca2+, entering the cells upon depolarization through  
voltage-dependent Ca2+ channels, and mediate a massive Ca2+-induced Ca2+ release 
(CICR) in cardiac and muscle cells 3. In non-excitable cells, like HeLa cells, the level of 
RyRs expression is modest. Correspondingly, caffeine, an agonist of RyRs, does not elicit 
a detectable increase in intracellular Ca2+ in HeLa cells 4. 
Ca2+ is a mediator of many processes, from contraction to apoptosis and cells at resting 
state keep the internal [Ca2+] at a low level (~100nM). The major source of Ca2+ 
contributing to cytoplasmic Ca2+ elevation is sarcoplasmic/ endoplasmic reticulum 
(SR/ER). To maintain high [Ca2+] inside the SR/ER cells possess sarco/endoplasmic 
reticulum Ca2+ – ATPase (SERCA) pumps 5. SERCA pump locates in the SR/ER 
membrane and couples the transport of Ca2+ from cytosolic to lumen spaces. HeLa cells 
expresses SERCA2b and SERCA3a isoforms of SERCA pump 6,7. Pharmacological 
block of SERCA by cyclopiazonic acid (CPA) or thapsigargin empties the ER Ca2+ stores 
and prevents Ca2+ release evoked by GPCRs activators histamine and CCh in HeLa 
cells8. 

Fig 1. Calcium signaling in Hela cells. IP3/RyR receptors and SERCA pump. 
A schematic of the various ways the intracellular Ca  concentration can increase. 
GPCRs activation is the most accepted mechanism for Ca  increase 
in Hela cells. The depletion of Ca  stores by CPA, a blocker of SERCA pump, 
prevents Ca release evoked by GPCR agonists carbachol and histamine.
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Experiments: 
Ca2+ signals in the HeLa cells will be measured with the Fluo-4 AM, a Ca2+ 

fluorescent indicator dye (Fig. 2). Fluo-4 AM posseses acetoxymethyl ester group which 
makes it membrane permeable. After penetration into the cells, dyes undergo de-
esterification by intrinsic esterases and remain trapped. Ca2+ bound Fluo-4 can be excited 
by blue light and emits green light 9. The intensity of the emitted light reflects the level of 
[Ca2+] in the cytoplasm, where Fluo-4 was accumulated. Therefore an increase in 
intracellular [Ca2+] evoked by application of different substances can be detected by rise 
of the fluorescence signal in Fluo-4 loaded cells. 
Three experiments should be performed (Fig. 3B): 

1) CCh/ histamine (1mM) induced Ca2+ release (IP3 receptors) 
2) Caffeine (10mM) induced changes in intracellular [Ca2+] (RyR receptors) 
3) CPA (10µM) mediated block of the CCh/ histamine induced Ca2+ release 

(SERCA pump). 
The experiments are designed to address the question which type of the Ca2+ release 
receptors - IP3 or RyR dominates in HeLa cells.  

Fig 2. Green-fluorescent calcium indicator Fluo-4. 
A. Chemical structure and spectral characteristic of Fluo-4. B. Schematic presentation 
of cell loading with AM form of Fluo-4 and live HeLa cells after 1 h loading with 5 µM Fluo-4 AM.

Absorption and fluorescence emission 
spectra of calcium saturated Fluo-4 AM
(Gee KR et al, “Cell calcium”, 2000)
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Live HeLa cells after 1 h loading with 5 µM Fluo-4 AM 
visualized using HI Plan 40x/0.5 Ph2 objective. 
(HBO lamp, GFP filter set, Leica 

Bar, 20 µm.
DMIL microscope, 

fluorescence-detection camera Canon Powershot G10 ). 

 
Experimental procedure: 
One day before the experiment: 
1) Prepare the cells: Take a coverslip with the forceps, dip it into 99% ethanol and flame 
to sterilize. Place three coverslips per one 35 mm Petri dish. Prepare four of such a Petri 
dishes. Seed cells on coverslips placed in Petri dishes ( 2 ml of cell suspension of density 
0.1 x 106 cells/ml per 35 mm Petri dish).  
 
 
 
 
 
 



2) Prepare the PSS and stocks of Fluo-4 AM, CCh, histamine, caffeine and CPA: 
PSS          Substance CatN FW mM Solvent mg/ml

  CatN FW MM g/liter  CCh C4382 182.65 100 water 18.27

NaCl 6781.1, Roth 58.44 140 8.18  Histamine H7125 111.15 100 water 11.12

KCL 3957.2, Roth 74.55 3 0.22  CPA C1530 336.38 10 DMSO 3.36
CaCl2 2382, Merck 147.02 3 0.44  Caffeine C0750 194.19 100 PSS 19.42

MgCl2 A375333, Merck 203.3 1 0.20  Fluo-4 AM F-14201 1096.95 2.5 DMSO 2.74
HEPES 9105.3, Roth 238.3 10 2.38  CCh aliquote to 100 µl, freeze at -20°C  
D-mannitol M-4125, Sigma 182.2 50 9.11  Histamine aliquote to 100 µl, freeze at -20°C  

pH 7.4 NaOH        CPA aliquote to 100 µl, freeze at -20°C  
      Caffeine keep at +4°C ( no more than 24h)  
      Fluo-4 AM 18.2 µl DMSO per 50µg, feeze at -20°C 
 
3) Obtain from your instructor or download the software for data analysis and install it at 
your laptops if possible (“Pazera Free MOV to AVI Convertor” www.pazera-
software.com, “VirtualDub” www.virtualdub.org and “ImageJ” http://rsbweb.nih.gov/ij/). 
The manual for Canon Powershot G10 is available at www.canon.com.  
4) Transfer all data from the SD memory cards located in your cameras to computers.  
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Experimental day: 
Loading of the cells with the Fluo-4 AM ( 1.2 h ): 

Dissolve 16 µl of 2.5 mM Fluo-4 AM stock solution in 8 ml of PSS in a 50ml 
tube. Then, cover this tube with aluminum foil to prevent photobleaching from unwanted 
exposure to ambient light. Take the cells seeded on coverslips out of the incubator. 
Remove the culture medium and replace it with PSS containing Fluo-4 AM (2 ml per 35 



mm Petri dish). Cover the Petri dishes with aluminum foil and keep them for 1 h at room 
temperature (RT). After 1 h of incubation with Fluo-4 AM, wash cells twice with PSS. 
Before recording, keep cells in the darkness for 20 min to allow de-esterification of the 
dye. 
During incubation and de-esterification processes :  

Prepare your drugs. Take the caffeine stock out of the refrigerator and let it warm 
to RT. Dilute stock solutions. Take a 1.5 ml eppendorf tube and add 900 µl of PSS and 
100 µl of 100 mM histamine stock to obtain 1 ml of the solution containing 10 mM 
histamine in PSS. Dilute CCh and CPA stocks solutions to 10 and 0.1 mM 
correspondently. 
Dilutions Initial stock Mix of  Resulted stock

   conc., mM Init stock,µl PSS, µl  conc., mM 
Histamine 100 900 100 10
CCh 100 900 100 10

CPA 10 990 10 0.1

Prepaire 30 nonsterile Petri dishes with the wax attached to the bottom (Fig. 3A). Do not 
apply a lot of wax as this could cause difficulties at fluorescence measurements. Switch 
the HBO lamp ON ( ~20 min before the experiment ). 
Experiments ( 2 h ): 

Take a 35 mm Petri dish with a wax layer at the bottom (Fig. 3A). Attach a 
coverslip with the Fluo-4 loaded cells to the wax and add 1.8 ml of PSS. Ensure that the 
coverslip is attached properly and does not move upon application of PSS. Reattach it if 
necessary with the forceps or take another Petri dish. Place your Petri dish under the 
microscope and visualize cells under 40x objective. Illuminate cells with the blue light 
using HBO lamp and GFP filter set. Evaluation under blue light should reveal the 
presence of green-fluorescent cells successfully loaded with Fluo-4 (Fig. 2B, lower part). 
Redirect the fluorescence signal to the Canon camera coupled to your microscope. Start 
video acquisition of fluorescent signal with the camera.( Operating with the Canon 
PowerShot G10: Switch on the camera; set video mode; set video resolution at 640x480 
pixels; set ISO to 1600; focus on the cells; press star button at the top right corner of the 
camera body; set gain to the maximum value using a control ring located at the right 
middle part of the camera body; start video acquisition.)  
Experiment 1: Collect a video for 30 seconds to monitor Ca2+ level before drug 
application. Add 200 µl of 10 mM CCh or histamine stock to reach a final concentration 
of 1mM in Petri dish. Continue the video capture for the next 1.5 min to detect 
CCh/histamine induced Ca2+ release (Fig 3B, experimental protocol 1). Repeat the 
experiment 3 times taking each time a fresh cell sample.  
Experiment 2: Collect a video for 30 seconds to monitor Ca2+ level before drug 
application. Add 200 µl of 100 mM caffeine stock to reach a final concentration of 
10mM in Petri dish. Continue the video capture for the next 1.5 min to detect caffeine 
induced changes in [Ca2+], if any (Fig 3B, experimental protocol 2). Add 200 µl of 10 
mM CCh or histamine stock to reach a final concentration of 1mM in Petri dish. Continue 
video capture for 1.5 min to detect CCh/histamine induced Ca2+ release. Repeat the 
experiment 3 times taking each time a fresh cell sample. 
Experiment 3: Before starting this experiment, cells should be incubated with 10 µM of 
CPA for ~20 min. Prepare 3 cell samples and add 200 µl of 0.1 mM CPA stock. During 



the incubation period, replace previously collected videos from the SD memory cards 
located in your cameras to computers. After CPA incubation, collect a video for 30 
seconds to monitor Ca2+ level before application of CCh or histamine (Fig 3B, 
experimental protocol 3). Add 220 µl of 10 mM CCh or histamine stock to reach a final 
concentration of 1mM in Petri dish. Continue the video capture for the next 1.5 min to 
detect CCh/histamine induced changes in [Ca2+], if any. Repeat the experiment 3 times 
taking each time a fresh cell sample. 
The videos will be taken at 30 frames per second (fps) with the resolution of 640x480 
pixels. The capacity of your SD memory card is restricted to about 2 Gb. This equates to 
23 minutes of videos (Canon PowerShort manual, p 283 ).  
Experimental 
video size   

# of 
experiments 

length of the
video, min 

total length, 
min 

Experiment 1 CCh/histamine 3 2 6 
Experiment 2 Caffeine and CCh/histamine 3 3.5 10.5 
Experiment 3 CPA and CCh/histamine 3 2 6 

      Total, min 22.5 

Transfer the resulted videos from the SD memory cards to computer for further analysis. 
 
Analysis of the results: ( analyze 1-2 videos with your instructor what will require ~0.5 
h;  analyze the  rest videos on your own) 
 

Fig 4. Analysis of the result using “ImageJ” software. 
Open a video converted to an old .AVI format. Select the areas within the cells 
using “ROI manager”. Calculate the fluorescence intensities within the cells 
over time using the “Multi measure” plugin. Save the result of the analysis (”Result window”) in a file. 
Open the resulted  file with “MS Excel” for the final analysis and graphical presentation.
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1) Convert videos obtained using Canon Powershot G10 from the .MOV to .AVI 
format ( software “Pazera Free MOV to AVI Convertor” ). Set output format 
as MPEG4. 

2) Convert further videos to the old .AVI format using “VirtualDub” utility. 
The resulted videos can be opened with “ImageJ” software. 



3) Analyze the fluorescent signal traces of the cells using ImageJ. 
3.1) Open a video with the ImageJ (menu item File->Open). The program 
activates “AVI Reader” window by file opening. To speed up file opening 
process, please check mark box “Use Virtual Stack”. Confirm your choice 
pressing “OK” button. 
3.2) Activate “Set Measurements” window (menu item Analyze->Set 
Measurements). To speed up the analysis process, please check mark box 
“Mean gray value” only. Confirm your choice pressing “OK” button. 
3.3) Activate “ROI manager” window (menu item Analyze->Tools->ROI 
manager). Check mark box “Show All” located at the bottom of “ROI 
manager” window. Click on the button “Oval selection tool” located under the 
menu item “File”. Select an area inside of a cell, so-called region of interest 
(ROI) (Fig. 4). Confirm your selection by clicking on the button “Add [t]” 
located at the right up corner of “ROI manager” window. Select all the cells of 
interest confirming each time your choice. At the end select an area outside of 
the cells to calculate background fluorescence level during your experiment.  
3.4) Activate “Multi Measure” window (menu item More-> Multi Measure in 
“ROI manager” window). Check mark boxes “Measure All Slices” and “One 
Row per Slice”. Confirm your choice clicking on the button “OK”. After a 
while, the program activates “Results” window (Fig. 4). Save the result of  
analysis (menu item File-> Save as… in “Results” window). The saved file 
can be opened by Microsoft Excel for final analysis. 

4) Open the resulted file with Excel. The file contains columns of numbers 
representing fluorescence levels detected in cells during your experiment. 
The last column is background fluorescence. First, subtract the background 
fluorescence from the fluorescence measured in cells. After that, calculate the 
fluorescence in cells before drug applications (Fo). Normalize  
the fluorescence intensities (F) to Fo. Present the result as a graph of the 
background corrected and normalized fluorescence intensities versus time as 
shown in Fig. 5. When you will calculate time scale, keep in mind that videos 
were taken at 30 fps. 
 

Fig 5. Example of carbachol-evoked calcium release in several individual HeLa cells. 
Cells were loaded for 1 h with 5 µM of Fluo-4 AM. Fluo4 loaded cells were excited by 
blue light, using the HBO lamp and the GFP filter set of Leica DMIL inverted microscope 
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Questions :  
1) What mechanism is responsible for the CCh and histamine induced Ca2+ 

releases in HeLa cells. Why CPA prevents these releases? 
2) Which type of the Ca2+ release receptors IP3 or RyR dominates in HeLa cells? 

Describe how your experiment might prove it? 
 
Materials, reagents, equipment and software: 

Materials: 
1) Round borosilicate glass coverslips (No.1; 12 mm diameter; cod. 0111520) 

purchased from Marienfeld GmbH 
2) 5 sterile Petri dishes, 35 mm diameter 
3) 50 nonsterile Petri dishes, 35 mm diameter 
4) Wax (White Wax Square Ropes, “J.A.W. Products, Inc.”, CatN 4101-0209) 
5) Forceps ( Inox, CatN 11200-10, “FST” ) 
6) Ethanol 99% 
7) A 50 ml tube 
8) 1.5 ml eppendorfs (10 pcs ) and 0.5 ml eppendorfs ( 30 pcs ) 
9) Aluminum foil 
Reagents: 
10) PSS ( in mM: NaCl 140, KCl 3, CaCl2 3, MgCl2 1, HEPES 10, D-mannitol 50; pH 

7.4 with th NaOH ), stored at +4°C 
11) Fluo-4AM, „Invitrogen“, # F14201, MW1096.95, DMSO soluble, stored at –20°C 
12) CCh, „Sigma“, # C4382, MW 182.65, water soluble, stored at RT 
13) Histamine, „Sigma“, # H7125, MW 111.15, water soluble, stored at –20°C 
14) CPA, “Sigma”, #C1530, MW 336.38, DMSO soluble, stored at –20°C 
15) Caffeine, “Sigma”, #C0750, MW 194.19, soluble in PSS, stored at RT 
Equipment: 
Leica DMIL inverted microscope equipped with transmitted and fluorescent light 
source ( HBO lamphouse ebq 50 ac), with a GFP filter set, an objective HI Plan 
40x/0.5 Ph2 and a fluorescence-detection camera Canon Powershot G10 coupled to 
the microscope using a homemade adapter. A laboratory timer. 
Software and manuals:  
1) Pazera Free MOV to AVI Convertor (free at www.pazera-software.com) 
2) VirtualDub (free at www.virtualdub.org) 
3) ImageJ (free at http://rsbweb.nih.gov/ij/) 
4) Microsoft Excel 
5) Manual for the Canon PowerShot G10 (free at http://www.canon.com/) 
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